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1 INTRODUCTION 

Le but de ce résumé est de présenter les principales fonctions du simulateur PSpice. Après 
une brève description générale, on trouvera une description de l’éditeur de schéma, quelques 
indications sur la préparation de la simulation, une description de la simulation et de l’affichage 
des résultats.  
Pour ce qui suit, on suppose que le lecteur est familiarisé avec les principales commandes de 
WINDOWS comme Ouvrir... Copier... Coller... etc... ces commandes ne seront pas passées 
en revue. 
 

2 PRESENTATION DE PSPICE 

2.1 Généralités 

Le logiciel PSpice de MicroSim Corporation, racheté par ORCAD, puis par Cadence est une 
version PC du simulateur SPICE. Ce simulateur peut être considéré comme le premier 
historiquement et l’un des principaux simulateurs analogiques. Par rapport à son ancêtre 
SPICE qui est uniquement un simulateur, PSpice comprend un éditeur de schéma et un module 
d’affichage des résultats qui rendent le logiciel plus agréable pour l’utilisateur. 
 
Le logiciel PSPICE comprend les modules suivants: 
 

 Les éditeurs de schéma Capture et Schematics  
 Le simulateur PSpice A/D   
 Le module d’affichage PROBE  
 Différents utilitaires qui ne seront pas traités dans le cadre de ce cours 
 

Dans ce qui suit, on se limitera à décrire l’éditeur de schéma Schematics 
 
Une session de travail avec PSPICE se déroule schématiquement de la façon suivante : 
 

 Dessin du schéma correspondant au circuit à simuler à l’aide de Schematics 
 Simulation avec PSpice A/D 
 Visualisation et impression des résultats avec PROBE 

 

2.2 Editeur de schémas Schematics 

Ce module permet les opérations suivantes : 
 

 Dessin et mise en page du schéma électrique 
 Test des connexions électriques 
 Génération d’un fichier ASCII décrivant le circuit électrique dans un format 

compatible avec le simulateur 
 

2.3 Simulateur PSpice A/D 

Ce module permet de simuler le fonctionnement du circuit et d’analyser son comportement 
suivant différents modes d’analyse. Le résultat de l’analyse est enregistré dans un fichier de 
format compatible avec le module de visualisation PROBE. 
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2.4 Module de visualisation PROBE 

Ce module permet de visualiser et d’imprimer les résultats calculés par PSpice A/D. Différentes 
fonctions (échelles logarithmiques, zoom, curseurs, analyse spectrale ...) facilitent 
l’interprétation des résultats. 
 

3 EDITION DE SCHEMAS 

3.1 Introduction 

Dans ce paragraphe, on décrira les opérations à effectuer pour éditer un schéma et le 
paramétrer en vue de la simulation. 
 
Remarque : 
 
Seules les principales commandes seront décrites ici. Pour plus de détails, le lecteur voudra 
bien se référer au volume intitulé « The Design Center, Schematic Capture User’s Guide  » de 
MicroSim Corporation. 
 

3.2 Librairies à dispositions 

Pour dessiner le schéma et pour établir le fichier de transfert avec le simulateur (fichier appelé 
netlist), l’éditeur de schéma travaille avec différentes librairies. Dans ces librairies, on trouve, 
sous forme codée, le symbole de l’élément à dessiner, ses interconnexions et ses paramètres. 
 
Dans le cadre de ce cours, les librairies suivantes sont à disposition: 
 
  eval.slb  éléments de base (R, L, C, diodes et transistors, AO, etc…) 
  digital.slb éléments CMOS numériques 
  source.slb sources (tension, courant en DC, sinus...) 
 
Remarque : 
 
Ces librairies peuvent être modifiées par l’utilisateur en utilisant l’éditeur de schéma, ceci en 
vue de définir un nouvel élément par exemple ou pour changer certains paramètres. Pour plus 
de détails, le lecteur voudra bien se référer au volume intitulé « The Design Center, Schematic 
Capture User’s Guide  » de MicroSim Corporation 
 
 

3.3 Dessin (capture) d’un élément 

Pour dessiner un élément : 
 

 aller dans le menu : Draw  -> Get new part... -> Browse... -> sélectionner une 
librairie et un élément (raccourci clavier : ctrl G ) 

 cliquer à, éventuellement aux, endroits où l’on désire positionner l’élément 
 cliquer sur le bouton de droite de la souris pour quitter l’élément  



Electronique Résumé 
Simulateur PSPICE 

 

HE-Arc/GHU Page 5/21 
12/12/2016  [Intro_PSPICE.DOC] 
 
 

 

3.4 Rotation d’un élément 

Pour effectuer une rotation de 90° sur un élément : 
 

 sélectionner l’élément en cliquant dessus  
 aller dans le menu : Edit  -> Rotate (raccourci clavier : ctrl R ) 
 

3.5 Retourner un élément 

Pour retourner un élément (effet miroir) : 
 

 sélectionner l’élément en cliquant dessus 
 aller dans le menu : Edit  -> Flip (raccourci clavier : ctrl F ) 

 

3.6 Dessin d’un fil 

Pour dessiner un fil : 
 

 aller dans le menu : Draw  -> Wire (raccourci clavier : ctrl W ) 
 cliquer à chaque coude du fil 
 double-cliquer à la fin du fil 

 

3.7 Modification des valeurs des éléments 

Pour définir les valeurs des éléments: 
 

 double-cliquer sur l’élément, une fenêtre volante apparaît 
 entrer les valeurs 

 
une autre possibilité consiste à : 
 

 double-cliquer sur la valeur par défaut de l’élément, une fenêtre volante apparaît 
 modifier la valeur par défaut 

 

3.8 Paramètres des résistances 

Les résistances sont définies par les paramètres suivants : 
 

 value =   qui définit la valeur de la résistance 
 TC =  qui définit le coefficient thermique de la résistance 

    (optionnel) 
 
 

3.9 Paramètres des capacités et des inductances 

Les capacités et les inductances sont définies par les paramètres suivants : 
 

 value =   qui définit la valeur de l’élément 
 IC =  qui définit le courant initial dans l’élément lors d’analyses   

  transitoires (optionnel) 
 



Electronique Résumé 
Simulateur PSPICE 

 

HE-Arc/GHU Page 6/21 
12/12/2016  [Intro_PSPICE.DOC] 
 
 

 

3.10 Paramètres des MOS 

Les MOS sont définis par la technologie employée. L’utilisateur ne peut modifier que la largeur 
(W) et la longueur (L) de ces éléments: 
 

 L =    définit la longueur du canal du MOS 
 W =  définit la largeur du canal du MOS 

 

3.11 Paramètres des transistors pnp 

Les transistors pnp sont définis par la technologie employée. L’utilisateur ne peut modifier que 
la surface de ces éléments par rapport au transistor pnp de base : 
 

 A =    définit la surface (valeur 1 par défaut) 
   

3.12 Paramètres de la source de tension sinusoïdale VSIN 

Lors de l’édition des paramètres de la source de tension sinusoïdale, la fenêtre suivante 
apparaît : 
 

 
 
La définition de ces paramètres est la suivante : 
 

 DC =   définit la valeur de la tension lors d’une analyse en continu 
 AC =  définit la valeur de la tension lors d’une analyse en alternatif 

    (incrémental) 
 
Les paramètres suivants concernent l’analyse en transitoire  
 

 VOFF = définit la tension de décalage (offset) 
 VAMPL = définit l’amplitude crête de la tension  
 FREQ = définit la valeur de la fréquence 
 TD =  définit le délai avant l’enclenchement de la source par  
   rapport à l’instant initial t = 0 
 DF =  facteur d’amortissement 
 PHASE = déphasage 
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3.13 Paramètres de la source de tension impulsionnelle VPUSLE 

Lors de l’édition des paramètres de la source de tension impulsionnelle, la fenêtre suivante 
apparaît : 
 

 
 
 
La définition de ces paramètres est la suivante : 
 

 DC =   définit la valeur de la tension lors d’une analyse en continu 
 AC =  définit la valeur de la tension lors d’une analyse en alternatif 

    (incrémental) 
 
Les paramètres suivants concernent l’analyse en transitoire  
 

 V1 =  définit la tension initiale 
 V2 =  définit la tension de l’impulsion  
 TD =  définit le délai avant l’enclenchement de la source par 
   rapport à l’instant initial t = 0 
 TR =  temps de montée du signal 
 TF =  temps de descente du signal 
 PW =  durée de l’impulsion 
 PER = période du signal 
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3.14 Paramètres de la source digitale FILESTIM 

Cette source de tension est utile pour générer des signaux logiques selon une séquence 
prédéfinie. Lors de l’ouverture de FILESTIM, la fenêtre suivante apparaît : 
 

 
 
avec : 
 

 File Name =  qui indique sous quel nom se trouve le fichier ASCII  
    correspondant à la séquence digitale désirée 

 SigName = qui correspond au nom du signal (doit figurer dans 
    le fichier ASCII) 
 
Les valeurs logiques des signaux admises sont : 
 
0 et 1 pour les états logiques 
X pour l’état indéterminé 
R pour la transition 0 à 1 
F pour la transition 1 à 0 
Z pour l’état haute impédance 
 
Exemple : 
 
On souhaite générer un signal de remise à zéro et une horloge avec les contraintes suivantes : 
 

 l’horloge a une période de 2 ms 
 l’impulsion de remise à zéro dure 1ms 
 l’horloge est à zéro pendant 4 ms après l’instant initial 
 l’horloge se nomme clk (SigName) 
 l’impulsion de remise à zéro se nomme reset (SigName) 
 les signaux seront enregistrés dans le fichier test.tst 

 
Pour appliquer ces signaux au circuit il faut : 
 

 connecter deux sources FILESTIM au circuit 
 définir ensuite, pour ces deux sources, le nom du fichier (test.tst dans cet exemple) 
 définir le nom (SigName) de chacun des signaux (clk et reset) pour chacune de ces 

sources 
 écrire à l’aide d’un éditeur de texte, en format ASCII, le fichier test.tst 
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Le fichier test.tst doit avoir le format suivant : 
 

 Remarques : 
clk, reset ne pas mettre d’espace ou return avant le début du 

fichier 
0ms 0 1 mettre une ligne vide avant les données 
1ms 0 0  
4ms 1 0 séparer les valeurs par des tabulateurs 
5ms 0 0  
6ms 1 0  
7ms 0 0  

 
  
 
 
 

3.15 Sources d’alimentation 

Lors du dessin du schéma, ne pas oublier la source de tension d'alimentation. La borne Vpwr  
est une aide pour le dessin mais elle n’est pas connectée par défaut à une source continue. 
Cette tâche incombe à l’utilisateur.  

3.16 Attribution de noms aux signaux 

Afin de faciliter l’examen des résultats, il est conseillé d’attribuer un nom aux signaux que l’on 
désire observer (Uout, Uin, Uc-r par exemple). Pour attribuer un nom à un fil, il faut : 
 

 double-cliquer sur le fil 
 entrer le nom du signal dans la fenêtre volante 

 
Remarque : 
 
Un nom de signal ne doit évidemment être utilisé que pour un seul et même fil. 
 

4 PREPARATION DE LA SIMULATION 

4.1 Introduction 

Dans PSpice tous les paramètres de simulation sont définis à partir de l’éditeur de schéma. En 
effet, le simulateur n’accepte que des instructions sous forme d’un fichier ASCII et l’utilisateur 
ne peut pas, en cours de simulation, modifier les paramètres d’analyse sans modifier ce fichier 
avec l’éditeur de schéma ou à l’aide d’un éditeur de texte (le BLOC-NOTE de Windows par 
exemple). Cette façon de procéder peut s’avérer peu pratique à l’usage puisqu’il faut revenir 
dans l’éditeur de schéma à chaque fois que l’on désire modifier les paramètres d’analyse ou 
utiliser un éditeur de texte. Par contre, en réalisant les modifications dans l’éditeur de schéma, 
la description de l’analyse se trouve automatiquement sauvegardée avec le schéma. D’autres 
simulateurs, comme SMASH par exemple,  permettent de modifier les paramètres d’analyse en 
cours de simulation.   

temps Etat de « reset » 

Etat de « clk » 
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4.2 Choix du type de simulation 

Les principaux types d'analyse possible sont illustrés ci-dessous, ils sont sélectionnés par le 
menu Analysis -> Setup. 
 
 
   

 
 
Les plus fréquemment utilisés sont : 
 
  AC sweep...  analyse en fréquence (incrémental) 
  DC sweep...  analyse en continu  
  Parametric...  analyse en fonction d’un paramètre 
  Temperature... analyse en température 
  Transient...  analyse transitoire 
  Monte Carlo ... analyse statistique 
  Options...  permet de modifier les paramètres du 
     simulateur 
La définition des paramètres de l’analyse se fait en cliquant sur le bouton concerné. 
 
Ne pas oublier de valider l'analyse en cochant la case Enabled  
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4.3 Analyse AC 

Ce type d’analyse permet une analyse en fonction de la fréquence en régime sinusoïdal 
incrémental. La fenêtre de définition se présente ainsi : 
 

 
 

avec : 
 

 AC Sweep Type  qui définit le type d’analyse (logarithmique ou 
      linéaire 

 Sweep Parameters  définit la fréquence de départ et d’arrivée ainsi 
      que le nombre de points d’analyse 

 Noise Analysis  permet une analyse du bruit du circuit 
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4.4 Analyse DC 

Ce type d’analyse permet une analyse en fonction d’une grandeur continue. La fenêtre de 
définition se présente ainsi : 
 

 
 

avec : 
 

 Sweep Var. Type  qui définit le type de variable continue 
     à employer   
 Sweep Type   qui définit le type d’analyse (logarithmique, 

      linéaire ou par série de valeurs) 
 Name   nom de la variable (V1 par exemple) 

      Attention, ne pas mettre un nom de signal 
      car ce dernier n’est pas le nom d’une variable 

 Start, End Value et Incr. définissent les valeurs de départ, d’arrivée et 
      l’incrément 
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4.5 Analyse paramétrique 

Ce type d’analyse permet une analyse en fonction d’un paramètre (valeur d’une résistance par 
exemple). La fenêtre de définition se présente et s’utilise de la même manière que celle de 
l’analyse DC. 

4.6 Analyse en température 

Ce type d’analyse permet de définir la température ambiante. Par défaut elle est fixée à 27 °C. 

4.7 Analyse en transitoire 

Ce type d’analyse permet une simulation au cours du temps. La fenêtre de définition se 
présente ainsi : 

 

 
 

avec : 
 
Print Step qui définit le pas d’affichage de l’analyse. 
 Ce paramètre n’a pas d’influence sur le  
 pas utilisé par le simulateur lors du calcul. 
Final Time définit la durée d’analyse 
Use Ini. Conditions valide l’utilisation des valeurs initiales 
 définies pour les éléments résistifs et 
 capacitifs 
Fourier Analysis permet une analyse de Fourier  
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4.8 Analyse selon Monte-Carlo 

Il s’agit d’une analyse statistique qui peut s’appliquer aux différents modes de simulation 
décrits ci-dessus. Lors de cette analyse, le simulateur fait varier, de façon aléatoire, les 
paramètres selon la définition faite dans le modèle de l’élément. Ce type d’analyse permet de 
tester la sensibilité du circuit face à la dispersion des éléments. La fenêtre volante se présente 
de la façon suivante : 
 

 
 

avec : 
 
Analysis qui définit le type d’analyse (worst case 
 ou Monte-Carlo) 
MC Runs définit le nombre d’analyse à effectuer. 
 Pour que le résultat soit statistiquement 
 significatif, choisir un nombre au moins  
 supérieur à 10 
Analyse Type définit sur quelle analyse sera effectuée 
 l’analyse statistique 
Output Var définit le signal de sortie. V(out) par 
 exemple 
MC Options Output sélectionne le nombre d’analyse qui 
 pourra être affiché. En général, on 
 choisira All. 
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4.9 Options 

Cette fonction permet de définir les paramètres utilisés par le simulateur. 
Plus précisément, ceci permet de varier la précision de calcul et les nombres d’itérations 
effectuées par le simulateur. En principe, ces valeurs sont définies par défaut et devraient 
convenir. En cas de problème de convergence, on peut modifier ces paramètres de la façon 
suivante : 
 
 RELTOL 0.01 modifie la tolérance relative 
 PIVTOL 1000 f modifie la tolérance du pivot 
 VNTOL 100 V modifie la tolérance sur les tensions 
 ABSTOL 1 nA modifie la tolérance sur les courants 
 ITL4 100 modifie le nombre maximum d’itérations 
 
Remarque : 
 
Il est préférable de ne pas changer tous ces paramètres en même temps. 

4.10 Fichiers utilisés par l’éditeur de schéma 

 L’éditeur de schéma enregistre la configuration du circuit dans un fichier qui 
présente l’extension .sch par défaut. 

 Après test des connexions électriques, il génère la netlist  qui est un fichier ASCII 
contenant la description du circuit (extension .net par défaut). On peut vérifier la 
bonne interconnexion du circuit en examinant ce fichier à l’aide de Analyse -> 
Examine Netlist. On ouvre automatiquement le bloc-notes de WINDOWS qui se 
présente alors de la façon suivante : 

 

 
 

 Lors du lancement de la simulation, l’éditeur de schéma génère le fichier de 
commande du simulateur (extension .cir par défaut). Ce fichier se présente 
également sous forme ASCII et peut, en cas de problème, être modifié en entrant à 
la main les différentes commandes PSpice. Un exemple de fichier de commande 
est illustré ci-dessous : 

 
* D:\MSIMEV60\ESSAI.SCH 
 
* Schematics Version 6.0 - January 1994 
* Tue Aug 23 10:23:43 1994 
 
** Analysis setup ** 
.ac DEC 10 10 1.00MEG 
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* From [SCHEMATICS NETLIST] section of msim.ini: 
.lib C:\PSPICE\LIB\ALP2.LIB 
.lib C:\PSPICE\LIB\filtres.lib 
 
.INC "ESSAI.net" 
.INC "ESSAI.als" 
 
.probe 

 
.END 

 L’éditeur de schéma génère en outre un fichier ASCII contenant les noms des 
noeuds du circuit (extension .als par défaut). Ce fichier se présente sous la forme 
suivante:  

 
* Schematics Aliases * 
 
.ALIASES 
R_R1        R1(1=in 2=out ) 
C_C1        C1(1=0 2=out ) 
V_V1        V1(+=in -=0 ) 
_    _(out=out) 
_    _(in=in) 
.ENDALIASES 

4.11 Librairies utilisées par l’éditeur de schéma 

Pour décrire un circuit, l’éditeur de schéma a besoin du dessin du symbole, des paramètres et 
des connexions des éléments. Ces informations sont enregistrées dans un fichier de librairie 
(extension .slb par défaut). Ce fichier est modifiable par l’utilisateur en utilisant la commande 
File -> Edit Library puis File -> Open -> nom de fichier. Plusieurs librairies peuvent être 
définies en fonction des besoins de l’utilisateur: dans le cadre de ce cours, on utilise les 
librairies suivantes: 

 
 eval.slb  éléments de base (R, L, C, diodes et transistors, AO, etc…) 
 digital.slb  éléments CMOS numériques 
 source.slb  sources (tension, courant en DC, sinus...) 
 

 

4.12 Circuits mixtes 

Le simulateur PSpice permet de simuler des circuits qui comportent une partie analogique et 
une partie numérique. Le modèle numérique des circuits est un modèle à 6 états dans lequel 
on prend en compte les deux états logiques, les temps de montée et de descente, l’état 
indéterminé et l’état à haute impédance (cf. paragraphe 4.13).  
 
Remarque : 
 
Le passage analogique-digital ou inversement, compte comme un élément dans le calcul du 
nombre d’éléments du circuit. Par exemple si l’on veut simuler un inverseur sur lequel on entre 
une tension et dont la sortie est connectée à une résistance, les éléments utilisés seront : la 
résistance, la source de tension, l’inverseur, le convertisseur A/D à l’entrée de l’inverseur et le 
convertisseur D/A à la sortie de l’inverseur.   
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5 SIMULATION 

5.1 Lancement de la simulation 

La simulation se lance avec Analyse -> Simulate (raccourci clavier : F11). Le simulateur 
affiche l’opération en cours dans une fenêtre semblable à celle ci-dessous : 
 

 
 

Lorsque la simulation est terminée, le programme lance automatiquement l'affichage. Le 
lancement automatique de PROBE peut être désactivé à l’aide du menu Analysis -> Probe 
Setup... 
 

5.2 Problèmes de convergence 

Le simulateur calcule les grandeurs du circuit à l’aide d’une méthode itérative. Dans certains 
cas, le simulateur signale qu’il rencontre des difficultés pendant la simulation. Il s’agit presque 
toujours de la procédure itérative qui ne converge pas. Pour remédier à ce genre de problème, 
il faut: 
 

 Eviter des flancs trop raides sur les sources impulsionnelles 
 
 Eventuellement modifier  les paramètres de simulation (cf. paragraphe 5.9) avec 

Analysis -> Setup -> Options...  
 

5.3 Fichiers utilisés par le simulateur 

 En plus des fichiers décrits dans le paragraphe 5.10, le simulateur génère un fichier 
ASCII contenant la description des opérations effectuées (extension .out par défaut). 
L’examen de ce fichier peut s’avérer utile en cas de problème, on y trouve, entre 
autre, les différentes librairies utilisées, la description du circuit et des modèles 
employés. Ce fichier peut être examiné à l’aide de Analyse -> Examine Output  et 
se présente de la façon suivante : 

 
 
**** 08/23/94 10:23:46 *********** Evaluation PSpice (Jan 1994) 
************** 
 
 * D:\MSIMEV60\ESSAI.SCH 
 
 ****     CIRCUIT DESCRIPTION 
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****************************************************************
*** 
 
* Schematics Version 6.0 - January 1994 
* Tue Aug 23 10:23:43 1994 
** Analysis setup ** 
.ac DEC 10 10 1.00MEG 
 
* From [SCHEMATICS NETLIST] section of msim.ini: 
.lib C:\PSPICE\LIB\ALP2.LIB 
.lib C:\PSPICE\LIB\filtres.lib 
 
.INC "ESSAI.net" 
 
**** INCLUDING ESSAI.net **** 
* Schematics Netlist * 
 
R_R1     in out 20k  
C_C1     0 out 5n  
V_V1     in 0  AC 1 
+SIN 0 1 1 0 0 0 
 
**** RESUMING ESSAI.CIR **** 
.INC "ESSAI.als" 
 
**** INCLUDING ESSAI.als **** 
* Schematics Aliases * 
 
.ALIASES 
R_R1        R1(1=in 2=out ) 
C_C1        C1(1=0 2=out ) 
V_V1        V1(+=in -=0 ) 
_    _(out=out) 
_    _(in=in) 
.ENDALIASES 
 
 
**** RESUMING ESSAI.CIR **** 
 
.probe 
 
.END 
 
**** 08/23/94 10:23:46 *********** Evaluation PSpice (Jan 1994) 
************** 
 
 * D:\MSIMEV60\ESSAI.SCH 
 
 ****     SMALL SIGNAL BIAS SOLUTION       TEMPERATURE =   
27.000 DEG C 
 
 
****************************************************************
**** 
 
 NODE   VOLTAGE     NODE   VOLTAGE     NODE   VOLTAGE     NODE   
VOLTAGE 
 
(   in)    0.0000  (  out)    0.0000   
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    VOLTAGE SOURCE CURRENTS 
    NAME         CURRENT 
 
    V_V1         0.000E+00 
 
    TOTAL POWER DISSIPATION   0.00E+00  WATTS 
 
 
 
          JOB CONCLUDED 
 
          TOTAL JOB TIME             .49 

 
   

 Le simulateur génère également le fichier utilisé par le module d’affichage (extension 
.dat par défaut) 

 

5.4 Librairies utilisées par le simulateur 

Pour simuler le fonctionnement d’un circuit, le simulateur a besoin d’un modèle associé à 
chaque élément. Ce modèle est enregistré dans un fichier de librairie (extension .lib par 
défaut). Ce fichier ASCII est modifiable par l’utilisateur en utilisant un éditeur de texte. 
Plusieurs librairies peuvent être définies en fonction des besoins de l’utilisateur: dans le cadre 
de ce cours, on utilise les librairies suivantes: 
 

 eval.lib contient les modèles des éléments de base  
 digital. lib contient le modèle de quelques circuits numériques 

 
Un exemple de modèle du NMOS est donné ci-dessous : 
 
*NMOS array 
 
.model NMOSa nmos LEVEL=3 Vto=0.58 dev 10mV Xj=0.15e-6 Nss=4.95e10 Cj=195e-6 
Theta=3.3e-2 
+ Cjsw=500e-12 Cgso=268e-12 Mjsw=0.29 Uexp=.125 Rsh=50 Tox=400e-10 Ld=0.15e-6 
+ Nfs=0.99e10 Delta=1.4 Eta=0.138 Kf=1.13E-23 Cgdo=268e-12 Pb=0.8 Utra=0 
+ Uo=620 dev 1% Nsub=8e16 Js=2e-5 Vmax=5.1e4 Kappa=0.4 Af=0 Mj=0.29 Ucrit=6.2e4 
Neff=4 
 
Pour plus de détails sur les paramètres utilisés, le lecteur voudra bien se référer au manuel 
intitulé « The Design Center, Circuit Analysis Reference Manual » de MicroSim Corporation et 
à « Semiconductor Device Modeling with Spice  » de P. Antognetti et G. Massobrio. 
 

6 MODULE D’AFFICHAGE DES RESULTATS PROBE 

6.1 Affichage des résultats 

Après simulation, le module d’affichage PROBE est automatiquement activé. Pour choisir le 
signal à visualiser : 
 

 Utiliser le menu Trace -> Add... 
 une fenêtre contenant le nom des signaux à disposition s’affiche 
 cliquer sur le ou les signaux à afficher 
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6.2 Affichage automatique 

Il est possible d’afficher automatiquement le ou les signaux désirés. Pour ce faire il faut : 
 

 définir dans l’éditeur de schéma les points à mesurer (tension, courant...) à l’aide du 
menu Markers... 

 dans l’éditeur de schéma activer l’affichage automatique des résultats en utilisant 
Analysis -> Probe Setup... 

6.3 Modification des axes 

Le menu Plot du module d’affichage permet de modifier les paramètres (domaines, linéaire, 
logarithmique...) des axes. La figure ci-dessous illustre la fenêtre volante qui concerne l’axe x: 
 

 
 
 

6.4 Utilitaires d’interprétation des résultats 

Le menu Tools... permet d’accéder à différents utilitaires : 
 

 Labels... permet d’ajouter du texte et des graphiques 
 Cursors... permet de mesurer les valeurs affichées. 

 Sélectionner un curseur en utilisant les boutons droite 
 et gauche de la souris 

 Options... valider Mark Data Points afin de visualiser les points  
 calculés par le simulateur 

6.5 Liste ASCII des résultats 

Il est possible d’obtenir une liste ASCII (extension .txt) des résultats calculés par le simulateur. 
Pour ce faire : 
 

 Dans l’éditeur de schéma, sélectionner le menu Analysis -> Probe Setup... 
 Valider l’option Text Data File Format (CSDF) 

 

6.6 Exportation des courbes 

L’impression du résultat de la simulation est possible sous PROBE en utilisant les commandes 
habituelles sous WINDOWS. Cependant, le résultat n’est souvent pas satisfaisant lorsqu’il 
s’agit d’inclure le résultat de simulation dans un document. La meilleure façon de procéder est 
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d’exporter le résultat dans une application WINDOWS (EXCEL ou WORD) et d’intégrer le 
graphique obtenu dans le document. 
 
Pour exporter des valeurs : 

 dans PROBE, sélectionner un signal en cliquant dessus 
 copier ce signal dans le presse-papiers de WINDOWS (ctrl C) 
 dans EXCEL (par exemple), coller le contenu du presse-papiers 

 
Cette méthode permet également de comparer les résultats de simulation avec les mesures 
relevées sous EXCEL. 
 

6.7 Ouverture d’un autre graphique 

Lorsque l’on souhaite afficher des tensions et des courants, il est mal pratique de les afficher 
sur le même graphique.  
Pour ouvrir un autre graphique :  

 utiliser le menu Plot -> Add Plot to Window 
 procéder ensuite de la même manière qu’au paragraphe 7.1 

 

6.8 Mesures 

Pour mesurer les valeurs simulées : 
 

 activer le menu “curseurs”  View -> Toolbars… cocher la case Cursors 

 dans le menu « curseurs » activer . Deux curseurs apparaissent ainsi 
qu’une fenêtre d’affichage du résultat de mesure (Probe cursor) 

 sélectionner un signal en cliquant sur la marque précédant le nom de ce 
dernier (le clic à droite ou à gauche permet de sélectionner l’un des deux 
curseur) 

 déplacer le curseur en maintenant enfoncé le bouton droit ou gauche de la 
souris 

 

6.9 Affichage en axes logarithmiques 

Pour changer basculer la représentation de l’axe X  de linéaire en logarithmique et 
inversement : 
 

 cliquer sur  
 
Pour changer basculer la représentation de l’axe Y  de linéaire en logarithmique et 
inversement : 
 

 cliquer sur  
 
Note : les graphiques sélectionnés ne doivent pas contenir des valeurs négatives ou nulles 
pour permettre un affichage de type logarithmique 
 

6.10 FFT 

Pour effectuer une analyse de Fourier (spectre en fréquence) d’un signal transitoire, cliquer sur 

 


